TMS320C8x PC Emulator
Installation Guide

Literature Number SPRU148A
D418009-9741 revision A
May 1997
IMPORTANT NOTICE

Texas Instruments (TI) reserves the right to make changes to its products or to discontinue any semiconductor product or service without notice, and advises its customers to obtain the latest version of relevant information to verify, before placing orders, that the information being relied on is current.

TI warrants performance of its semiconductor products and related software to the specifications applicable at the time of sale in accordance with TI’s standard warranty. Testing and other quality control techniques are utilized to the extent TI deems necessary to support this warranty. Specific testing of all parameters of each device is not necessarily performed, except those mandated by government requirements.

Certain applications using semiconductor products may involve potential risks of death, personal injury, or severe property or environmental damage ("Critical Applications").

TI SEMICONDUCTOR PRODUCTS ARE NOT DESIGNED, INTENDED, AUTHORIZED, OR WARRANTED TO BE SUITABLE FOR USE IN LIFE-SUPPORT APPLICATIONS, DEVICES OR SYSTEMS OR OTHER CRITICAL APPLICATIONS.

Inclusion of TI products in such applications is understood to be fully at the risk of the customer. Use of TI products in such applications requires the written approval of an appropriate TI officer. Questions concerning potential risk applications should be directed to TI through a local SC sales office.

In order to minimize risks associated with the customer’s applications, adequate design and operating safeguards should be provided by the customer to minimize inherent or procedural hazards.

TI assumes no liability for applications assistance, customer product design, software performance, or infringement of patents or services described herein. Nor does TI warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right of TI covering or relating to any combination, machine, or process in which such semiconductor products or services might be or are used.

Copyright © 1997, Texas Instruments Incorporated
WARNING

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can radiate radio frequency energy and has not been tested for compliance with the limits of computing devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable protection against radio frequency interference. Operation of this equipment in other environments may cause interference with radio communications, in which case the user at his own expense will be required to take whatever measures may be required to correct this interference.

TRADEMARKS

MS-DOS, Windows, and Windows NT are registered trademarks of Microsoft Corporation.

PC is a trademark of International Business Machines Corporation.

Pentium is a trademark of Intel Corporation.
Contents

1 Installing the Emulator and C Source Debugger ........................................ 1-1
   Lists the hardware and software you'll need to install the emulator board and C source debugger; provides installation instructions for PC systems running Windows NT or Windows 95.
   1.1 What You'll Need ................................................................. 1-2
       Hardware checklist ............................................................ 1-2
       Software checklist ............................................................ 1-2
   1.2 Step 1: Installing the Emulator Board in Your PC .................................... 1-4
       Preparing the emulator board for installation ............................. 1-4
       Setting the emulator board into your PC .................................... 1-6
   1.3 Step 2: Connecting the Emulator to Your Target System .............................. 1-8
   1.4 Step 3: Installing the Debugger Software ........................................... 1-9
   1.5 Step 4: Setting Up the Debugger Environment ........................................ 1-10
       Invoking the new or modified batch file .................................... 1-11
       Modifying the PATH statement ............................................. 1-11
       Setting up the environment variables ..................................... 1-12
       Identifying the correct I/O switches ....................................... 1-13
       Resetting the emulator ....................................................... 1-14
   1.6 Step 5: Describing Your Target System to the Debugger ............................. 1-15
   1.7 Step 6: Verifying the Emulator Driver Installation .................................. 1-16
       Troubleshooting ............................................................... 1-16
   1.8 Step 7: Verifying the Emulator and Debugger Installation .......................... 1-18
       Installation error messages ................................................... 1-19

2 Release Notes ................................................................. 2-1
   Describes release enhancements and miscellaneous changes for the current release.
   2.1 Release Enhancements ....................................................... 2-2
       Window Resizing on PCs ..................................................... 2-2
       Window Resizing on All Platforms (–bl and –bw) .......................... 2-2
       Multiple Watch Windows ................................................... 2-2
       Multiple Memory Windows .................................................. 2-3
       Improved Command Line Editing .......................................... 2-3
       New Command SAFEHALT .................................................. 2-4
       New Command LINE ........................................................ 2-4
       New PC Debugger Option (–font) .......................................... 2-4
2.2 Additional Features ................................................................. 2-5
C I/O support (–o option) .............................................................. 2-5
Global breakpoints ................................................................. 2-5
Little-endian support .............................................................. 2-5
Memory accesses less than a word ........................................... 2-6
Memory access alignment ....................................................... 2-6
Viewing the data cache (CACHEVIEW command) ..................... 2-7
Disabling caching ................................................................. 2-7

A Installing the Emulator Device Driver Manually ....................... A-1
    Provides instructions for installing the emulator driver manually.
A.1 Copying the Device Driver File and Invoking the Registry Editor .................. A-2
A.2 Setting Up the Genport Directory ........................................ A-3
A.3 Setting Up the Values for the Genport Directory ....................... A-4
A.4 Setting Up the Parameters Directory and Values ....................... A-6
### Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>Emulator Board I/O Switches</td>
<td>1-4</td>
</tr>
<tr>
<td>1–2</td>
<td>Emulator Board Installation</td>
<td>1-6</td>
</tr>
<tr>
<td>1–3</td>
<td>Emulator Target Cable and Board</td>
<td>1-7</td>
</tr>
<tr>
<td>1–4</td>
<td>Typical Setup Using the ‘C8x Emulator and Your Target System</td>
<td>1-8</td>
</tr>
<tr>
<td>1–5</td>
<td>Connecting the ‘C8x Emulator to Your Target System</td>
<td>1-8</td>
</tr>
<tr>
<td>1–6</td>
<td>Command Setup for the Debugger</td>
<td>1-10</td>
</tr>
</tbody>
</table>

### Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>Emulator Board Switch Settings</td>
<td>1-5</td>
</tr>
<tr>
<td>1–2</td>
<td>Your Switch Settings</td>
<td>1-5</td>
</tr>
<tr>
<td>1–3</td>
<td>Options for Use With D_OPTIONS</td>
<td>1-13</td>
</tr>
<tr>
<td>1–4</td>
<td>Identifying Nondefault I/O Address Space</td>
<td>1-13</td>
</tr>
</tbody>
</table>
Installing the Emulator and C Source Debugger

This chapter helps you install the C8x emulator board and the C source debugger on a 32-bit x86-based or Pentium™ PC running Windows NT™ or Windows 95. When you complete the installation, turn to the TMS320C80 (MVP) C Source Debugger User’s Guide.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 What You’ll Need</td>
<td>1-2</td>
</tr>
<tr>
<td>1.2 Step 1: Installing the Emulator Board in Your PC</td>
<td>1-4</td>
</tr>
<tr>
<td>1.3 Step 2: Connecting the Emulator to Your Target System</td>
<td>1-8</td>
</tr>
<tr>
<td>1.4 Step 3: Installing the Debugger Software</td>
<td>1-9</td>
</tr>
<tr>
<td>1.5 Step 4: Setting Up the Debugger Environment</td>
<td>1-10</td>
</tr>
<tr>
<td>1.6 Step 5: Describing Your Target System to the Debugger</td>
<td>1-15</td>
</tr>
<tr>
<td>1.7 Step 6: Verifying the Emulator Driver Installation</td>
<td>1-16</td>
</tr>
<tr>
<td>1.8 Step 7: Verifying the Emulator and Debugger Installation</td>
<td>1-18</td>
</tr>
</tbody>
</table>
What You’ll Need

1.1 What You’ll Need

The following checklists detail items that are shipped with the 'C8x C source debugger and emulator and additional items you’ll need to use these tools.

**Hardware checklist**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>host</td>
<td>A 32-bit x86-based or Pentium™ PC with an ISA/EISA bus</td>
</tr>
<tr>
<td>memory</td>
<td>Minimum of 16 megabytes of RAM plus 32 megabytes of hard-disk space for swap files</td>
</tr>
<tr>
<td>display</td>
<td>Monochrome or color (color recommended)</td>
</tr>
<tr>
<td>slot</td>
<td>One 16-bit ISA/EISA bus slot</td>
</tr>
<tr>
<td>emulator board</td>
<td>A board with a 'C8x device</td>
</tr>
<tr>
<td>power requirements</td>
<td>Approximately 1 ampere @ 5 volts (5 watts)</td>
</tr>
<tr>
<td>target system</td>
<td>A board with a 'C8x device</td>
</tr>
<tr>
<td>connector to target system</td>
<td>14-pin connector (two rows of seven pins)—for more information about this connector, refer to the JTAG/MPSD Emulation Technical Reference.</td>
</tr>
<tr>
<td>required hardware</td>
<td>A CD-ROM drive</td>
</tr>
<tr>
<td>optional hardware</td>
<td>An EGA- or VGA-compatible graphics display card and a large monitor. The debugger has two options that allow you to change the overall size of the debugger display. If you have an EGA- or VGA-compatible graphics card, you can take advantage of some of these larger screen sizes. These larger screen sizes are most effective when used with a large (17” or 19”) monitor.</td>
</tr>
</tbody>
</table>

**Software checklist**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Windows NT or Windows 95</td>
</tr>
<tr>
<td>software tools</td>
<td>TMS320C8x assembler, linker, and C compiler</td>
</tr>
<tr>
<td>CD-ROMs</td>
<td>TMS320C80 (MVP) Online Reference</td>
</tr>
<tr>
<td></td>
<td>TMS320C8x Emulator</td>
</tr>
</tbody>
</table>
What You'll Need

required files

† mpemu.exe is the executable file that invokes the MP version of the C source debugger for the emulator.

† ppmu.exe is the executable file that invokes the PP version of the C source debugger for the emulator.

† emurst.exe resets the 'C8x emulator.

† pdm.exe is the executable file for the parallel debug manager environment.

† board.dat describes your target board to your debugger in terms of what devices are in the emulation scan path.

† genport.sys is the Windows NT emulator device driver.

optional files

† composer.exe is a utility that allows you to convert your text board configuration file (board.cfg) into a format the debugger can read (board.dat).

† board.cfg is a text file that describes your target board in terms of what devices are on the emulation scan path.

† init.cmd is a general-purpose batch file that contains debugger commands. The version of this file that's shipped with the debugger defines a 'C8x memory map. If this file isn’t present when you first invoke the debugger and you don’t use the –t option, all memory is invalid initially. When you first start using the debugger, this memory map should be sufficient for your needs. Later, you may want to define your own memory map. For information about setting up your own memory map, refer to the Defining a Memory Map chapter in the TMS320C80 (MVP) C Source Debugger User’s Guide.

† init.clr is a general-purpose screen configuration file. If this file isn’t present when you invoke the debugger, the debugger uses the default screen configuration.

† The default configuration is for color monitors; an additional file, mono.clr, can be used for monochrome monitors. When you first start to use the debugger, the default screen configuration should be sufficient for your needs. Later, you may want to define your own custom configuration.

For information about these files and about setting up your own screen configuration, refer to the Customizing the Debugger Display chapter in the TMS320C80 (MVP) C Source Debugger User’s Guide.

† Included as part of the debugger package
1.2 Step 1: Installing the Emulator Board in Your PC

This section contains the hardware installation information for the emulator.

Preparing the emulator board for installation

Before you install the emulator board, you must be sure that the board’s switches are set to correctly identify the I/O space that the board can use. The emulator uses 32 bytes of the PC I/O space; two switches on the board identify this space.

Figure 1–1 shows where these switches are on the emulator and identifies the switch numbers.

Switches are shipped in the default settings shown here and are listed in Table 1–1. If you use an I/O space that differs from the default, change the switch settings. Table 1–1 shows alternate settings.

In most cases, you can leave the switch settings in the default position. However, you must ensure that the ‘C8x emulator I/O space does not conflict with other bus settings. For example, if you’ve installed a bus mouse in your system, you may not be able to use the default switch settings for the I/O space—the mouse might use this space. Refer to your PC technical reference manual and your other hardware-board manuals to see if there are any I/O space conflicts. If you find a conflict, use one of the alternate settings shown in Table 1–1.

Figure 1–1. Emulator Board I/O Switches
Step 1: Installing the Emulator Board in Your PC

Table 1–1. Emulator Board Switch Settings

<table>
<thead>
<tr>
<th>Address Range</th>
<th>Switch #</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0240–0x025F</td>
<td>1: on; 2: on</td>
</tr>
<tr>
<td>0x0280–0x029F</td>
<td>1: on; 2: off</td>
</tr>
<tr>
<td>0x0320–0x033F</td>
<td>1: off; 2: on</td>
</tr>
<tr>
<td>0x0340–0x035F</td>
<td>1: off; 2: off</td>
</tr>
</tbody>
</table>

Some of the other installation steps require you to know which switch settings you used. If you reset the I/O switches, note the modified settings here for later reference.

Table 1–2. Your Switch Settings

1) To minimize the risk of electric shock and fire hazard, be sure that all major components that you interface with Texas Instruments devices are limited in energy and certified by one or more of the following agencies: UV, CSA, VDE, or TUV.

2) To minimize the risk of personal injury, always turn off the power to your PC and unplug the power cord before installing the ’C8x emulator board.
Step 1: Installing the Emulator Board in Your PC

Setting the emulator board into your PC

After you’ve prepared the emulator board for installation, follow these steps:

1) Turn off the power to the PC, and unplug the power cord.

2) Remove the cover of your PC.

3) Remove the mounting bracket from an unused 16-bit ISA/EISA bus slot.

4) Install the emulator board in the slot (see Figure 1–2).

5) Tighten down the mounting bracket.

6) Plug the emulator target cable into the emulator board (see Figure 1–3). The cable is a 25-pin DSUB connector, shaped to ensure proper connection.

7) Replace the PC cover.

8) Plug in the power cord, and turn on the power to the PC.

Figure 1–2. Emulator Board Installation
Step 1: Installing the Emulator Board in Your PC

**Figure 1–3. Emulator Target Cable and Board**

Don’t connect or disconnect the target cable to or from the ‘C8x emulator board while the PC is powered up.

Be very careful with the target cable connectors. Connect them gently; forcing the connectors into position may damage them.

Remember, the connector is keyed. Be sure to connect the cable so that the key fits into its slot.
1.3 Step 2: Connecting the Emulator to Your Target System

Figure 1–4 shows a typical setup using the emulator, target cable, and your target system.

Figure 1–5 shows how you connect the emulator and target cable to your target system. In most cases, the target system will be a 'C8x board of your own design.

Figure 1–4. Typical Setup Using the 'C8x Emulator and Your Target System

Figure 1–5. Connecting the 'C8x Emulator to Your Target System
1.4 Step 3: Installing the Debugger Software

To install the debugger software on a PC running Windows NT or Windows 95, follow these steps:

1) Log on as Administrator or as a user with administrative privileges (Windows NT only).
   You must have administrative privileges to install the emulator device driver under Windows NT.

2) Insert the TMS320C8x Emulator CD-ROM into your CD-ROM drive.

3) From the File menu (Windows NT 3.51) or the Start menu (Windows NT 4.0 or Windows 95), select Run.

4) In the dialog box, enter the following command (replace d with the name of your CD-ROM drive):
   
   ```
   d:\setup.exe
   ```

5) Click on OK.

6) Follow the on-screen instructions.

If you choose not to have the environment variables set up automatically, see Section 1.5, Setting Up the Debugger Environment, for alternate ways that you can set up the environment variables.
1.5 Step 4: Setting Up the Debugger Environment

To ensure that your debugger works correctly, you must:

- Modify the PATH statement to identify the c8xdebug directory.
- Define environment variables so that the debugger can find the files it needs.
- Identify any nondefault I/O space used by the emulator.
- Reset the emulator board.

Not only must you do these things before you invoke the debugger for the first time, you must do them any time you power up or reboot your PC.

You can accomplish these tasks by entering individual commands, but it’s simpler to put the commands in a batch file. You can edit your system’s autoexec.bat file; in some cases, modifying the autoexec.bat file may interfere with other applications running on your PC. So, if you prefer, you can create a separate batch file that performs these tasks.

Figure 1–6 (a) shows an example of an autoexec.bat file that contains the suggested modifications (highlighted in bold type). Figure 1–6 (b) shows a sample batch file that you could create instead of editing the autoexec.bat file (for the purpose of discussion, assume that this sample file is named initdb.bat). The subsections following the figure explain these modifications.

Figure 1–6. Command Setup for the Debugger

(a) Sample autoexec.bat file to use with the debugger and emulator

```
DATE
TIME
ECHO OFF
PATH=C:\DOS;C:\WINDOWS;C:\C8XTOOLS\BIN;C:\c8xdebug
SET A_DIR=C:\C8XTOOLS\LIB;C:\C8XTOOLS\EXEC\LIB
SET C_DIR=C:\C8XTOOLS\LIB;C:\C8XTOOLS\EXEC\LIB
SET D_DIR=C:\C8XTOOLS\LIB;C:\c8xdebug
SET D_SRC=C:\C8XCODE
SET D_OPTS=-P 240
CLS
EMURST
```
Figure 1–6. Command Setup for the Debugger (Continued)

(b) Sample initdb.bat file to use with the debugger and emulator

```
PATH=C:\c8xdebug;\%PATH\%

SET D_DIR=C:\c8xdebug
SET D_SRC=C:\C8XCODE
SET D_OPTIONS=-P 240
EMURST
```

Invoking the new or modified batch file

- If you modify the autoexec.bat file, be sure to invoke it before invoking the debugger for the first time. To invoke this file, enter:

  AUTOEXEC

- If you create an initdb.bat file, you must invoke it before invoking the debugger for the first time. You'll need to invoke initdb.bat any time that you power up or reboot your PC. To invoke this file, enter:

  INITDB

Modifying the PATH statement

To invoke the debugger without specifying the name of the directory that contains the debugger executable file, define a path to the debugger directory. The general format is:

```
PATH=C:\c8xdebug
```

- If you are modifying an autoexec that already contains a PATH statement, simply include `;C:\c8xdebug` at the end of the statement, as shown in Figure 1–6 (a).

- If you are creating an initdb.bat file, use a different format for the PATH statement, as shown in Figure 1–6 (b):

  `````PATH=C:\c8xdebug;\%PATH\%```'

  The addition of `;\%path\%` ensures that this PATH statement won't undo PATH statements in any other batch files (including the autoexec.bat file).
Step 4: Setting Up the Debugger Environment

Setting up the environment variables

An environment variable is a special system symbol that the debugger uses for finding or obtaining certain types of information. The debugger uses three environment variables named D_DIR, D_SRC, and D_OPTIONS. The next three steps tell you how to set up these environment variables. The format for doing this is the same for both the autoexec.bat and inittdb.bat files.

- Set up the D_DIR environment variable to identify the c8xdebug directory:
  
  ```plaintext
  SET D_DIR=C:\c8xdebug
  ```

  (Be careful not to precede the equal sign with a space.)

  This directory contains auxiliary files (emurst, init.cmd, etc.) that the debugger needs.

- Set up the D_SRC environment variable to identify any directories that contain program source files that you’ll want to look at while you’re debugging code. The general format for doing this is:

  ```plaintext
  SET D_SRC=pathname1;pathname2...
  ```

  (Be careful not to precede the equal sign with a space.)

  For example, if your ‘C8x programs were in a directory named c8xcode on drive C, the D_SRC setup would be:

  ```plaintext
  SET D_SRC=C:\C8XCODE
  ```

- You can use several options when you invoke the debugger. If you use the same options over and over, it’s convenient to specify them with D_OPTIONS. The general format for doing this is:

  ```plaintext
  SET D_OPTIONS= [object filename] [debugger options]
  ```

  (Be careful not to precede the equal sign with a space.)

  This tells the debugger to load the specified object file and use the specified options each time you invoke the debugger. Table 1–3 lists the options that you can identify with D_OPTIONS.

  Note that you can override D_OPTIONS by invoking the debugger with the –x option.

  For more information about options, see the Debugger Options section in the Overview of a Code Development and Debugging System chapter in the TMS320C80 (MVP) C Source Debugger User’s Guide.
Step 4: Setting Up the Debugger Environment

Table 1–3. Options for Use With D_OPTIONS

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>–b[b]</td>
<td>Select the screen size</td>
</tr>
<tr>
<td>–d machinename</td>
<td>Display debugger on different machine (X Windows only)</td>
</tr>
<tr>
<td>–f filename</td>
<td>Identify a new board configuration file</td>
</tr>
<tr>
<td>–i pathname</td>
<td>Identify additional directories</td>
</tr>
<tr>
<td>–n processorname</td>
<td>Identify the name of the processor</td>
</tr>
<tr>
<td>–o</td>
<td>Enable C I/O</td>
</tr>
<tr>
<td>–p port address</td>
<td>Identify the I/O address space</td>
</tr>
<tr>
<td>–s</td>
<td>Load the symbol table only</td>
</tr>
<tr>
<td>–t filename</td>
<td>Identify a new initialization file</td>
</tr>
<tr>
<td>–v</td>
<td>Load without the symbol table</td>
</tr>
</tbody>
</table>

**Identifying the correct I/O switches**

Refer to your entries in Table 1–2 (page 1-5). If you didn’t modify the I/O switches, skip this step.

If you modified the I/O switch settings, you must use the debugger’s –p option to identify the I/O space that the emulator is using. You can do this each time you invoke the debugger, or you can specify this information by using the D_OPTIONS environment variable. Table 1–4 lists the nondefault I/O switch setting and the appropriate line that you can add to the autoexec.bat or initdb.bat file.

Table 1–4. Identifying Nondefault I/O Address Space

<table>
<thead>
<tr>
<th>Address Range</th>
<th>switch #</th>
<th>Add this line to the batch file</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0280–0x029F</td>
<td>on</td>
<td>off</td>
</tr>
<tr>
<td>0x0320–0x033F</td>
<td>off</td>
<td>on</td>
</tr>
<tr>
<td>0x0340–0x035F</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
Resetting the emulator

To reset the 'C8x emulator, add this line to the autoexec.bat or initdb.bat file:

```
emurst
```

**Note:**

The emurst program resets the 'C8x emulator only; it doesn’t apply reset to the 'C8x device on your target board. If you cycle the power to your target board, you **must** execute emurst before you invoke the debugger.
1.6 Step 5: Describing Your Target System to the Debugger

In order for the debugger to understand how you have configured your target system, you must supply the target configuration information in a file for the debugger to read.

- If you’re using an emulation scan path that contains only one 'C8x device and no other devices, you can use the board.dat file that comes with the 'C8x emulator kit. This file describes to the debugger the single 'C8x device in the scan path and gives the 'C8x device the name MVP1. Since the debugger automatically looks for a file called board.dat in the current directory and in the directories specified with the D_DIR environment variable, you don’t need to create your own board configuration file. Go to the next section.

- If you plan to use a different target system, you must follow these steps:

  **Step 1:** Create the board configuration file.
  
  **Step 2:** Translate the board configuration file to binary so that the debugger can read it.
  
  **Step 3:** Specify the configuration file when invoking the debugger.

These steps are described in the Describing Your Target System to the Debugger appendix in the TMS320C80 (MVP) C Source Debugger User’s Guide.
1.7 Step 6: Verifying the Emulator Driver Installation

To ensure that you have correctly installed the emulator driver, follow these steps:

1) Turn off the power to the 'C8x target board.
2) Connect the JTAG cable from your PC to the 'C8x target board.
3) Turn on the power to the 'C8x target board.
4) If a hard RESET is not generated automatically after power-up, apply a hard RESET to the 'C8x device.
5) From the command prompt in a MS-DOS window, enter:

   `emurst`

   You should see a message similar to the following:

   XDS510 IS RESET, HARDWARE VERSION 3

   If this message appears, you have correctly installed the emulator driver. Turn to Section 1.8, Step 8: Verifying the Emulator and Debugger Installation.

   If you see this message:

   CANNOT DETECT TARGET POWER

   follow the troubleshooting tips in the following section.

Troubleshooting

- The target power is not on or the cables are not connected.
  
  Be sure that power is applied to the target board and that the JTAG cable is connected firmly.

- The I/O switch settings on the 'C8x emulator board don’t match the value specified with the –p option.

  If you are using nondefault I/O switch settings, you must specify the corresponding –p option in either the D_OPTIONS environment variable or on the command line when you invoke the debugger.

- The emulator driver is not installed properly.

  Before running the debugger, you must first reboot your PC for the registry changes to take effect. If you did not reboot at the completion of the installation program, do so now.
Step 6: Verifying the Emulator Driver Installation

You must have administrative privileges to install the emulator device driver under Windows NT. Check to see if the driver is listed in the Windows NT registry under:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Genport

If you do not see the Genport key, reinstall the emulation software. If it still does not appear, you may need to contact your system administrator for help. You can also try to install the emulator driver manually as outlined in Appendix A.
1.8 Step 7: Verifying the Emulator and Debugger Installation

To ensure that you have correctly installed the emulator and debugger software, double-click on the mpemu icon or enter this command at the system prompt:

```
mpemu c:\c8xdebug\hello \-n MVP1_MP \-o
```

If you see a display similar to this one, you have correctly installed your emulator and debugger.

If you see a display and the lines of code say Invalid address or the fields in the MEMORY window are shown in red, the debugger may not be able to find the init.cmd file. Check for the file in the directories specified by the D_DIR environment variable or ensure that the file is in the current directory. Re-enter the command above.

If you don’t see a display, then your debugger or emulator board may not be installed properly. Go back through the installation instructions and be sure that you have followed each step correctly; then re-enter the command above.
Installation error messages

While invoking the debugger, you may see the following message:

```
CANNOT INITIALIZE THE TARGET !!
  - Check I/O configuration
  - Check cabling and target power
Init error -1
```

One of several of the following conditions may be the cause; check:

- Is the target power on?
- Is the emulator board installed firmly?
- Is the cable connecting your emulator and target system loose?
- Is your target board getting the correct voltage?
- Is your port address set correctly:
  - Does the emurst command appear at the end of either your autoexec.bat or initdb.bat file? This command must be executed after you powered up the target board.
    - Check to be sure the –p option used with the D_OPTIONS environment variable matches the I/O address defined by your switch settings (refer to Your Switch Settings, Table 1–2, and Identifying Nondefault I/O Address Space, Table 1–4).
    - Check to see if you have a conflict in address space with another bus setting. If you have a conflict, change the switches on your board to one of the alternate settings in Table 1–1. Modify the –p option of the D_OPTIONS environment variable to reflect the change in your switch settings.
- Was the –f option specified on the command line or in the D_OPTIONS environment variable (where the default file specified by the –f option is board.dat) specifying a file that the debugger can’t find?
  - If you didn’t provide any path information with the filename, the debugger couldn’t find the file in the current directory or in any of the directories listed in the D_DIR environment variable.
  - If you didn’t provide the correct path information, re-execute the debugger, specifying the correct pathname and filename for the board configuration file.
Step 7: Verifying the Emulator and Debugger Installation

- Was the –n MVP1_MP option specified when you invoked the debugger? You must use the –n option so that the debugger knows which C8x device on your target system you want to debug.

- Was the processor name specified with the –n option in your board configuration file?

After you have checked all of the above, repeat the verification instructions in Section 1.8.
This chapter contains documentation of features that are new or have been changed since the last release. This is not an exhaustive list of all code changes since the last release, but it is a list of all of the changes that may require modifications to your debugger batch or initialization files, or makefiles, so please take time to read this chapter completely.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 Release Enhancements</td>
<td>2-2</td>
</tr>
<tr>
<td>2.2 Additional Features</td>
<td>2-5</td>
</tr>
</tbody>
</table>
2.1 Release Enhancements

Window Resizing on PCs

The maximum window width has been increased from 80 characters to 132.

Window Resizing on All Platforms (–bl and –bw)

The command line options –bl and –bw have been added to allow the debugger window to be initialized to any length or width.

Syntax:

–bl #

where # specifies the length (in lines). The default length is 25 lines and the maximum is 60. Do not enter a space between –bl and #.

–bw #

where # is the width (in characters). The default width is 80 characters and the maximum is 132. Do not enter a space between –bw and #.

Multiple Watch Windows

An optional fourth parameter (window name) has been added to the WA (Watch Add) command to allow you to watch your expression in an alternative watch window. You can create as many watch windows as you desire. A new watch window will appear each time a unique window name is specified.

Syntax:

wa expression[, [label] [, display format] [, window name]]]

Example:

wa i,,,New_Watch_Window

To remove an expression from an alternative watch window, you must specify the window name.

Syntax:

wd index number [, window name]

Example:

wd 1,New_Watch_Window
To remove an alternative watch window, specify the *window name* or * if you want to remove all watch windows.

**Syntax:**

```
wr [window name | *]
```

**Example:**

```
wr New_Watch_Window
```

**Multiple Memory Windows**

An optional third parameter (*window name*) has been added to the MEM command. It allows you to create as many memory windows as you desire. A new memory window will appear each time a unique window name is specified.

**Syntax:**

```
mem expression[, [display format] [, window name]]
```

**Example:**

```
mem 0x02000000,,New_Mem_Window
```

**Improved Command Line Editing**

Editing in the command window and dialog windows has changed slightly. The following keystrokes have new or different meanings.

- **Backspace**: Backspace will delete characters to the left of the cursor, and move characters to the right of the cursor to the left by one space. It leaves the cursor in the position previously held by the character just deleted.

- **Left Arrow**: Moves the cursor to the left. From there, characters can be overwritten, deleted, or inserted. Before this change, the left arrow and backspace had the same function.

- **Carriage Return**: The entire command string, as it appears in the command window, is passed to the debugger. This is regardless of where the cursor is located at the time.

- **CNTRL–K**: All characters to the right of the cursor are deleted.
Release Enhancements

**New Command SAFEHALT**

The SAFEHALT command prevents mouse clicks from halting the target while it is running. When the debugger is placed in SAFEHALT mode, only the <ESC> key or breakpoints will halt the target while running. The default is off.

Syntax:

```
SAFEHALT ON | OFF
```

**New Command LINE**

The LINE command causes the FILE window to display the specified line number. If the line number is already displayed in the FILE window, the command has no effect. If the line number is not currently displayed, the contents of the FILE window are repositioned so that the line number appears in the middle of the FILE window.

Syntax:

```
LINE num
```

**New PC Debugger Option (–font)**

The –font option is only available on PCs. It will search through your PC’s terminal fonts and use a font which is closest to num points high by 2/3 num points wide. This option is useful to view multiple debuggers that are running at the same time.

Syntax:

```
–font num
```

The recommended value for num is 8.
2.2 Additional Features

The features described in this section are not new to this release. They are listed here because they are not documented in the current revision of the TMS320C80 (MVP) C Source Debugger User’s Guide.

C I/O support (–o option)

If you plan to debug a program that uses the standard C I/O facilities, you must invoke the MP or PP debugger with the –o option. When you use the –o option, the debugger sets up a special environment with the host machine for performing I/O functions. This environment will not be set up if you do not use the –o option.

The –o option was added to prevent more than one debugger from attempting to set up the special C I/O environment when multiple 'C8x debuggers are running. Since only one debugger (or processor) can be using the C I/O facilities at a time, the –o option allows you to explicitly identify which debugger will set up the environment.

This change may require you to modify the PDM initialization files or script files that you use to invoke the debuggers.

Global breakpoints

You can use global breakpoints, through the use of the EMU0/1 pins (when connected as shown in the JTAG/MPSD Emulation Technical Reference), to halt multiple processors across multiple 'C8x devices. The EMU0 pin is also used as a carry out for the RUNB counter. See the Using the Analysis Interface chapter in the TMS320C80 (MVP) C Source Debugger User’s Guide for details on global breakpoints.

A Breakpoints Disable selection has been added to the Analysis break events dialog box, allowing you to disable the bus breakpoints without disabling the EMU0/1 driven low breakpoint.

Little-endian support

Both MP and PP debuggers now support little-endian 'C8x operation. Before invoking a debugger (MP or PP), you must reset to the 'C8x device (through the RESET pin) to set the 'C8x device’s endian order. To change the endian order of the 'C8x device, you must quit all debuggers that are active, reset the 'C8x device, then restart the debuggers. See the TMS320C80 Data Sheet for information about the RESET pin.
When the 'C8x device is configured for big-endian operation, the address of values in the MEMORY window are referenced from the MSB. If the 'C8x device is configured for little-endian operation, the address of values in the MEMORY window are referenced from the LSB.

Memory accesses less than a word

In previous revisions of the emulator, all memory accesses were performed on word or doubleword address boundaries. If an access was performed that required less than a word (byte or halfword):

- For a read operation, the emulator performed a word read and then extracted the required data.
- For a write operation, the emulator performed a word read, modified the data, and then performed a word write.

This version of the emulator accesses only the addresses requested. If a byte or halfword is requested, the emulator performs the appropriate memory operation to access only the requested data. For example:

```c
?*(char *)0x02000000 = 0x12
```

For this example, previous revisions performed a word read from memory, modified the word with the byte data, and then performed a word write. The current revision simply performs a byte write of the data.

Memory access alignment

The emulator now automatically aligns accesses to the 'C8x device's natural address boundaries. If you request a short data type on an odd-byte address boundary, the emulator performs two byte accesses. If you request an int (integer) data type on an odd-byte address, the emulator performs a byte access, a halfword access, followed by a byte access.
**Viewing the data cache (CACHEVIEW command)**

The CACHEVIEW command has been added for this release. This command toggles the view of all memory accesses generated by the debugger between the data cache view and the external memory view.

- When the data cache view is enabled (default), memory writes are performed to both the cache and the external memory location (cache write through).
- When the external memory view is enabled, memory writes are performed only with the external memory location.

**Disabling caching**

When the emulator is performing memory operations, it caches memory accesses. If you request a byte, the emulator may read up to eight full words to service its internal cache, and then extract the byte from that data. To disable caching for memory locations that you want to access individually (such as a memory mapped I/O port), use the MA command to map the address as an I/O port. See the Defining a Memory Map chapter in the TMS32080 (MVP) C Source Debugger User's Guide for more information on I/O port mapping.
Appendix A

Installing the Emulator Device Driver Manually

You must install the emulator device driver (genport.sys) in the Windows NT registry to enable the debugger to communicate with the emulator. If you are using Windows 95, please disregard this appendix. The emulator device driver is only used by Windows NT.

The setup utility should be able to install and register the emulator device driver for you automatically. However, if for some reason there is a problem, you can install the driver manually by performing the following steps:

1) Log on as Administrator or as a user with administrative privileges.
2) Copy the device driver file and invoke the registry editor.
3) Set up the Genport directory.
4) Set up the values for the Genport directory.
5) Set up the Parameters directory and values.

This appendix describes these steps.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1 Copying the Device Driver File and Invoking the Registry Editor</td>
<td>A-2</td>
</tr>
<tr>
<td>A.2 Setting Up the Genport Directory</td>
<td>A-3</td>
</tr>
<tr>
<td>A.3 Setting Up the Values for the Genport Directory</td>
<td>A-4</td>
</tr>
<tr>
<td>A.4 Setting Up the Parameters Directory and Values</td>
<td>A-6</td>
</tr>
</tbody>
</table>
A.1 Copying the Device Driver File and Invoking the Registry Editor

The TMS320C8x Emulator CD-ROM includes a genport.sys file that contains information about the emulator device driver. You must copy this file to the Windows NT drivers directory. Once you do so, you can use the registry editor to register the genport.sys parameters, allowing the emulator and debugger to communicate.

1) Copy genport.sys to the Windows NT drivers directory. For example:

   copy c:\c8xdebug\genport.sys %systemroot%\system32\drivers

2) Invoke the registry editor:

   regedt32

   The registry editor brings up several windows.

The remaining sections in this appendix tell you how to register the genport.sys parameters.
A.2 Setting Up the Genport Directory

1) After you invoke the registry editor, locate the window called HKEY_LOCAL_MACHINE on Local Machine and select the SYSTEM\CurrentControlSet\Services directory icon.

![Registry Editor Screenshot](example.png)

2) While the Services directory icon is highlighted, select Edit → Add Key from the menu bar. This displays the Add Key dialog box:

![Add Key Dialog](example.png)

3) Enter Genport as the Key Name, then click on the OK button. This causes the Genport directory icon to appear under the Services directory (you may need to scroll the window to see the Genport directory).
A.3 Setting Up the Values for the Genport Directory

1) Click on the Genport directory icon to make it active (highlighted), then select Edit → Add Value from the menu bar. This displays the Add Value dialog box:

![Add Value Dialog Box]

2) Enter ErrorControl as the Value Name, select REG_DWORD as the Data Type, then click on the OK button. This displays the DWORD editor dialog box:

![DWORD Editor Dialog Box]

3) Enter 1 as the Data, select Hex as the Radix, then click on the OK button.

4) Click on the Genport directory icon to make it active (highlighted), then select Edit → Add Value from the menu bar. This displays the Add Value dialog box.

5) Enter Group as the Value Name, select REG_SZ as the Data Type, then click on the OK button. This displays the String Editor dialog box:

![String Editor Dialog Box]

6) Enter Extended Base as the String, then click on the OK button.
7) Repeat steps 1–3 with the following information:

<table>
<thead>
<tr>
<th>Value Name</th>
<th>Data Type</th>
<th>Data</th>
<th>Radix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>REG_DWORD</td>
<td>2</td>
<td>Hex</td>
</tr>
<tr>
<td>Type</td>
<td>REG_DWORD</td>
<td>1</td>
<td>Hex</td>
</tr>
</tbody>
</table>

The following values should appear in the registry editor when the Genport directory icon is highlighted:

![Registry Editor Screenshot](image-url)
A.4 Setting Up the Parameters Directory and Values

1) Click on the Genport directory icon to make it active, then select Edit → Add Key from the menu bar. This displays the Add Key dialog box.

2) Enter Parameters as the Key Name, then click on the OK button. This causes the Parameters directory icon to appear under the Genport directory.

3) Click on the Parameters directory to make it active, select Edit → Add Value from the menu bar, then enter the following information:
   - Value Name: IoPortAddress
   - Data Type: REG_DWORD
   - Data: 240
   - Radix: Hex

4) Repeat step 3 with the following information:
   - Value Name: IoPortCount
   - Data Type: REG_DWORD
   - Data: 1000
   - Radix: Hex

The following values should appear in the registry editor when the Parameters directory icon is highlighted:

5) Exit the registry editor, then reboot your PC. This completes the manual driver installation process.
Index

A

addresses
  I/O address space 1-4 to 1-5 1-13
assembler 1-2
autoexec.bat file 1-10 to 1-14
  invoking 1-11
  sample 1-10

B

–b debugger option
  with D_OPTIONS environment variable 1-13
batch files
  autoexec.bat 1-10 to 1-14
    sample 1-10
  board.cfg 1-3
  board.dat 1-3
  emurst 1-3 1-14
  init.clr 1-3
  init.cmd 1-3
  initdb.bat 1-10 to 1-14
    sample 1-11
  mono.clr 1-3
–bl debugger option 2-2
  board.cfg file 1-3
  board.dat file 1-3 1-15
breakpoints
  global 2-5
–bw debugger option 2-2

C

C I/O facilities
  enabling 2-5
c8xdebug directory 1-12
CACHEVIEW command 2-7
command line editing 2-3
composer utility 1-3
configuration file
  board.cfg 1-3
  board.dat 1-3 1-15
  composer utility 1-3
connector
  target system to emulator 1-7
customizing the display
  init.clr file 1-3
  mono.clr file 1-3

D

–d debugger option
  with D_OPTIONS environment variable 1-13
D_DIR environment variable 1-12
D_OPTIONS environment variable 1-12
D_SRC environment variable 1-12
data cache
  disabling 2-7
  viewing 2-7
desktop
  debugging 2-1
  communicating with your target system 1-15
  environment setup 1-10 to 1-14
    error messages 1-19 to 1-20
    verifying 1-18 to 1-20
  resizing windows 2-2
  watch windows 2-2
Index

**default**
- I/O address space: 1-4 to 1-5
- memory map: 1-3
- screen configuration file
  - color displays: 1-3
  - monochrome displays: 1-3
- switch settings: 1-4 to 1-5

**device driver**
- genport.sys file: 1-3
  - installation
    - manual installation: A-1 to A-6
    - troubleshooting: 1-16 to 1-17
    - verifying: 1-16 to 1-17

**directories**
- c8xdebug directory: 1-12
- for auxiliary files: 1-12
- for debugger software: 1-11
- identifying additional source directories: 1-12

**display requirements**: 1-2

**E**

**editing the command line**: 2-3

**emulator**
- additional tools: 1-2
- connection to target system: 1-8
- custom switch settings: 1-5
- debugger environment
  - debugger installation: 1-10 to 1-14
  - error messages: 1-19 to 1-20
  - verifying: 1-16 to 1-20
- host system: 1-2
- I/O address space
  - installation
    - board: 1-4 to 1-7
    - debugger software: 1-3
    - error messages: 1-19 to 1-20
    - into PC: 1-6 to 1-7
    - preparation: 1-4 to 1-3
    - verifying: 1-18 to 1-20
- memory
  - default map: 1-3
  - operating system: 1-2

**emulator (continued)**
- requirements
  - CD-ROM drive: 1-2
  - display: 1-2
  - graphics card: 1-2
  - hardware: 1-2
  - memory: 1-2
  - mouse: 1-2
  - power: 1-2
  - software: 1-2
- resetting: 1-3
- screen configuration files: 1-3
- switch settings: 1-4 to 1-5
- target cable: 1-7
- target system: 1-2
- emurst file: 1-3
  - verifying the device driver installation: 1-16
- enhancements: 2-2 to 2-4
- environment variables
  - D_DIR: 1-12
  - D_OPTIONS: 1-12
  - D_SRC: 1-12
  - for debugger options: 1-12
  - identifying auxiliary directories: 1-12
  - identifying source directories: 1-12
- error messages
  - installation: 1-19 to 1-20

**F**
- –f debugger option
  - troubleshooting: 1-19
  - with D_OPTIONS environment variable: 1-13
- –font debugger option: 2-4

**G**
- Genport directory
  - entering values: A-4 to A-5
  - setting up: A-3
- genport.sys file: 1-3
- global breakpoints: 2-5
- graphics card requirements: 1-2

**H**
- hardware checklist: 1-2
- host system: 1-2
I

–i debugger option 1-13
  with D_OPTIONS environment variable
I/O address space 1-4 to 1-5 1-13
I/O switch settings default settings 1-4 to 1-5
init.clr file 1-3
init.cmd file 1-3
initdb.bat file 1-10 to 1-14
  invoking 1-11
  sample 1-11
installation
debugger software 1-9
  error messages 1-19 to 1-20
  verifying 1-18 to 1-20
device driver
  manual installation A-1 to A-6
  troubleshooting 1-16 to 1-17
  verifying 1-16 to 1-17
emulator 1-4 to 1-7
  error messages 1-19 to 1-20
  verifying 1-18 to 1-20
invoking
  autoexec.bat file 1-11
  initdb.bat file 1-11

K

keystrokes redefined 2-3

L

LINE command 2-4
linker 1-2
little-endian support 2-5

M

memory
  access
    alignment 2-6
    less than a word 2-6
  default map 1-3
  disabling data cache 2-7
memory (continued)
  mapping
    init.cmd file 1-3
    requirements 1-2
    viewing cache memory 2-7
memory windows
  creating multiple 2-3
messages
  installation errors 1-19 to 1-20
  mono.clr file 1-3
  mouse requirements 1-2
mpeemu command
  options
    D_OPTIONS environment variable 1-12
  verifying the installation 1-18

N

–n debugger option 1-13
  with D_OPTIONS environment variable

O

–o debugger option 1-13
  using standard C I/O facilities 2-5
  with D_OPTIONS environment variable 1-13
  operating system 1-2
  optional files 1-3 to 1-5

P

–p debugger option 1-13
  with D_OPTIONS environment variable 1-19
  Parameters directory
    entering values 1-19
    setting up 1-19
PATH statement 1-11
PDM command 1-3
port address 1-19
power requirements
  board 1-2
ppemu command
  options
    D_OPTIONS environment variable 1-12

Index-3
regedt32 file A-2
registry editor invoking A-2
Genport directory entering values setting up A-4 to A-5
installing the device driver A-1 to A-6
Parameters directory entering values setting up A-6
release notes 2-1 to 2-7
required files 1-3
required tools 1-2
resetting emurst file 1-3 1-14
resizing debugger windows 2-2

–s debugger option with D_OPTIONS environment variable 1-13
SAFEHALT command 2-4
software checklist 1-2
switch settings default settings 1-4 to 1-5
I/O address space 1-4 to 1-5 1-13
your settings 1-5

–t debugger option with D_OPTIONS environment variable 1-13
target cable connections 1-7
target system 1-2
connection to emulator 1-8
describing to the debugger 1-15

–v debugger option with D_OPTIONS environment variable 1-13

verifying installation
debugger and emulator 1-18 to 1-20
device driver 1-16 to 1-17

–x debugger option 1-12

WA command 2-2
watch windows creating multiple 2-2
removing 2-3
removing an expression from window resizing 2-2

Windows 95
CD-ROM drive requirements 1-2
CD-ROMs 1-2
display requirements 1-2
error messages installation 1-13
graphics card requirements 1-2
hardware requirements 1-2
host system 1-2
memory requirements 1-2
mouse requirements 1-2
operating system 1-2
power requirements 1-2
setting up debugger environment 1-10
software requirements 1-2
target system 1-2

Windows NT
CD-ROM drive requirements 1-2
CD-ROMs 1-2
display requirements 1-2
error messages installation 1-13 to 1-16
graphics card requirements 1-2
hardware requirements 1-2
host system 1-2
memory requirements 1-2
mouse requirements 1-2
operating system 1-2
power requirements 1-2
setting up debugger environment 1-10 to 1-14
software requirements 1-2
target system 1-2

–x debugger option 1-12